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Animacijos istorija 
 

Animacijos istorija: nuo piešinių iki skaitmeninių technologijų 

Animacijos istorija yra ilga ir įspūdinga, prasidėjusi dar prieš kino atsiradimą. Pagrindiniai animacijos 

vystymosi etapai rodo, kaip technologijos ir kūrybiškumas pakeitė šią meno formą. 

 

1. Ankstyvosios animacijos užuomazgos 

Pre-kinematografiniai eksperimentai (prieš XIX a.) 

Pirmieji bandymai sukurti iliuziją, kad vaizdai juda, buvo pastebimi jau senovės civilizacijose. Pvz., 

urvų piešiniuose matomi daugkartiniai to paties gyvūno atvaizdai, rodantys judėjimo suvokimą. 

XIX a. pradžia – buvo kuriami optiniai žaislai, kurie suteikė judėjimo iliuziją:  
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Thaumatrope (1825 m.) – diskelis su dviem skirtingais piešiniais, kurie sukant greitai susilieja į vieną 

vaizdą. 

Phenakistoscope (1832 m.) – besisukanti disko plokštelė su atvaizdais, sukuriančiais animacijos efektą. 

Zoetrope (1834 m.) – cilindras su piešinių seka, kuris sukant suteikdavo judesio iliuziją. 

 

 

2. Pirmieji animaciniai filmai 

XIX a. pabaiga – XX a. pradžia 

Pirmieji kino išradimai leido animaciją paversti vizualiniu menu. 

Émile Reynaud (1892 m.) – sukūrė pirmąją projekcinę animaciją „Pantomimes Lumineuses“, 

naudodamas savo išradimą „Praxinoscope“. 

J. Stuart Blackton (1900 m.) – sukūrė pirmąją animuotą filmuotą sceną „The Enchanted Drawing“, 

kurioje piešiniai ekrane keitėsi. 

Winsor McCay (1911 m.) – pristatė animaciją „Little Nemo“, o vėliau sukūrė vieną pirmųjų žinomų 

animacinių filmų „Gertie the Dinosaur“ (1914 m.), kur animuotas veikėjas sąveikavo su animatoriumi. 

 

3. Aukso amžius: Holivudas ir garsioji animacija (1920–1950 m.) 

Walt Disney (1928 m.) – „Steamboat Willie“ buvo pirmoji animacija su sinchronizuotu garsu, 

pristatanti Mikį Pūkuotuką. 

1937 m. – „Snieguolė ir septyni nykštukai“ – pirmasis pilnametražis animacinis filmas. 

Warner Bros., MGM ir kiti Holivudo gigantai pradėjo kurti animacinius serialus, tokius kaip „Looney 

Tunes“, „Tom & Jerry“ ir kt. 

 

4. Pokario animacijos plėtra (1950–1980 m.) 

Japonija tapo svarbiu animacijos centru, kur studija Toei Animation (1956 m.) pradėjo kurti anime. 

1960-aisiais atsirado televizijos animacija (The Flintstones – pirmasis televizijos animacinis serialas). 

Technologijų pažanga leido kurti spalvingesnę ir sudėtingesnę animaciją. 

 

5. Skaitmeninės animacijos era (1980–dabar) 

CGI animacija (1980–1990 m.) – kompiuterinė grafika pakeitė tradicinius metodus.  
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„Toy Story“ (1995 m.) – pirmasis pilnametražis kompiuterinės grafikos animacinis filmas. 

2D ir 3D animacijos hibridai – tokios studijos kaip Pixar, DreamWorks ir Disney pradėjo kurti 

pažangias animacijas. 

Animacija žaidimuose ir virtualioje realybėje – šiuolaikinės technologijos, tokios kaip „Blender“, 

„Unreal Engine“ ir „Unity“, leidžia kurti dinamišką animaciją. 

 

 

Išvada 

Animacijos istorija – tai kelionė nuo paprastų piešinių iki itin sudėtingų kompiuterinių animacijų. 

Šiandien animacija naudojama ne tik pramogoms, bet ir švietimui, reklamai bei interaktyvioms 

medijoms. 

Animacijos ateitis gali būti dar įdomesnė, nes dirbtinis intelektas ir virtuali realybė leidžia kurti naujas 

interaktyvias ir įtraukiančias patirtis!  

Skaitmeninės animacijos įranga 
 

Skaitmeninė animacija kuriama naudojant įvairią įrangą, kurią galima suskirstyti į šias pagrindines kategorijas: 

 

1. Aparatinė įranga (Hardware) 

Skaitmeninei animacijai reikalinga galinga įranga, leidžianti greitai apdoroti vaizdus ir kurti aukštos kokybės 

animaciją. 

a) Kompiuteriai 

Galingas procesorius (CPU) – svarbus skaičiavimo greičiui, ypač jei naudojami 3D modeliai ar sudėtingos 

simuliacijos. 

Vaizdo plokštė (GPU) – būtina greitam renderinimui („NVIDIA GeForce RTX“ arba „AMD Radeon Pro“ 

dažniausiai naudojamos animacijai). 

Daug RAM atminties – rekomenduojama bent 16–32 GB, jei dirbama su sudėtingais projektais. 

Greitas SSD diskas – užtikrina greitą failų įkėlimą ir darbą su dideliais duomenų kiekiais. 

💡 Pavyzdys: „Apple Mac Studio“, „Asus ProArt“, „Dell XPS“ arba surinktas galingas kompiuteris su „NVIDIA 

RTX“ grafine korta. 

b) Grafinės planšetės 

„Wacom Cintiq“, „Huion Kamvas“, „XP-Pen Artist“ – naudojamos piešti ir animuoti 2D ar 3D modelius. 
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„iPad Pro“ su „Apple Pencil“ – mobilus sprendimas 2D animacijai (pvz., naudojant „Procreate“ ar 

„RoughAnimator“). 

c) Judesio fiksavimo įranga (Motion Capture) 

„Perception Neuron“, „Xsens“, „Rokoko“ – skirti 3D animacijos veikėjų judesių sekimui realiuoju laiku. 

„Microsoft Kinect“ – pigesnė alternatyva, skirta paprastam judesių sekimui. 

d) Virtualios realybės (VR) įranga 

„Oculus Quest“, „HTC Vive“, „Valve Index“ – naudojami interaktyviai animacijai ir 3D modeliavimo aplinkoms, 

pvz., „Gravity Sketch“ arba „Quill VR“. 

 

2. Programinė įranga (Software) 

a) 2D animacijos programos 

„Adobe Animate“ – standartinė vektorinės animacijos programa. 

„Toon Boom Harmony“ – profesionali animacijos programa, naudojama studijose („Cartoon Network“, 

„Disney“). 

„Krita“ – atviro kodo programa su 2D animacijos funkcijomis. 

„OpenToonz“ – naudojama studijose kaip „Studio Ghibli“. 

„Synfig Studio“ – atviro kodo alternatyva vektorinėms animacijoms kurti. 

b) 3D animacijos programos 

„Blender“ – nemokama ir galinga programa, naudojama modeliavimo, animacijos ir efektų kūrimui. 

„Autodesk Maya“ – profesionalų standartas Holivudo animacijoms. 

„Cinema 4D“ – lengvai naudojama 3D animacijos programa. 

„3ds Max“ – dažnai naudojama žaidimų kūrimui ir specialiesiems efektams. 

c) Animacijos ir vizualinių efektų programos 

„Adobe After Effects“ – naudojama efektams, titrams ir animacijoms. 

„Moho (Anime Studio)“ – vektorinė animacijos programa su rigging sistema. 

„Houdini“ – naudojama realistiškiems efektams ir sudėtingoms animacijoms („Pixar“, „Marvel“ studijose). 

d) Garso redagavimo ir įrašymo programos 

„Adobe Audition“, „Audacity“, „Reaper“ – naudojamos garso takeliams, balso sinchronizacijai ir efektams. 

 

3. Animacijos gamybos priedai 
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a) Žalias fonas (Green Screen) 

Naudojamas fone, kad būtų galima lengvai pakeisti aplinką animacijos kompozicijoje. 

b) Apšvietimas 

Studijinis LED apšvietimas naudojamas stop-motion animacijai arba realių vaizdų integracijai į animaciją. 

c) Vaizdo fiksavimo įranga 

„DSLR“ ar „Mirrorless“ kameros naudojamos stop-motion animacijai kurti. 

 

Apibendrinimas 

💡 Skaitmeninės animacijos įranga gali būti pritaikoma pagal poreikius: 

✔ Pradedantiesiems – „Blender“, „Krita“, „Adobe Animate“ su grafine planšete. 

✔ Pažengusiems – „Autodesk Maya“, „Toon Boom Harmony“, judesių fiksavimo įranga. 

✔ Profesionalams – pilna studijos įranga su VR įrankiais, judesių sekimu ir 3D modeliavimu. 

Šiandien animacijos kūrimo galimybės yra itin plačios ir prieinamos tiek pradedantiesiems, tiek profesionalams!  

 

Pasiruošimas filmo gamybai 

 

Filmo gamyba prasideda nuo paruošiamojo etapo, kuris yra būtinas norint sukurti aiškią viziją, 

apibrėžti idėją ir struktūrizuoti kūrybinį procesą. Šis etapas padeda užtikrinti, kad gamybos metu viskas 

vyks sklandžiai ir atitiks numatytą kūrybinę kryptį. 

 

1. Paruošiamasis etapas 

Tai pirmasis ir svarbiausias filmo kūrimo žingsnis, kuriame: 

Formuojama pagrindinė idėja. 

Nustatomas filmo žanras, tikslinė auditorija ir stilistika. 

Atliekamas idėjos vystymas ir vaizdinės medžiagos rinkimas. 

Pagrindiniai kūrybiniai sprendimai priimami prieš pradedant techninę gamybą. 

2. Idėjos ir sąvokos (Concept Development) 

Pagrindinė idėja: Tai trumpas filmo aprašymas, kuris nusako pagrindinę temą ir prasmę. 

Sąvokos kūrimas: Apima stilistiką, atmosferą, emocinį poveikį ir pasakojimo toną. 
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Inspiracija: Atliekami tyrimai, ieškoma vizualinių, literatūrinių ar istorinių šaltinių, kurie padėtų plėtoti 

idėją. 

💡 Pavyzdys: Jei filmo idėja – mokslinė fantastika, gali būti naudojamos idėjos iš klasikinių sci-fi filmų 

ar knygų. 

 

3. Siužeto vystymas 

Siužetas – tai istorijos vystymosi eiga nuo pradžios iki pabaigos. 

Siužeto kūrimo procesas dažnai remiasi trijų veiksmų struktūra:  

Įvadas (Exposition) – pristatomi veikėjai, pasaulis, problema. 

Veiksmo kulminacija (Conflict/Climax) – įvyksta didžiausia istorijos drama ar veiksmas. 

Pabaiga (Resolution) – išsprendžiami pagrindiniai klausimai, užbaigiama istorija. 

Kuriant siužetą, dažnai naudojamas naratyvinis lankas (Story Arc), kuris padeda struktūrizuoti įvykių 

seką. 

 

4. Vaizdinių analogų tyrimai 

Ieškoma vaizdinių įkvėpimo šaltinių – nuotraukos, meno kūriniai, kiti filmai, komiksai, gamtos 

peizažai. 

Moodboard‘ai (nuotaikų lentos) – naudojamos siekiant perteikti būsimą filmo atmosferą ir spalvinę 

gamą. 

Studijuojami kiti filmai, serialai ar animacijos, siekiant suprasti, kaip vizualiai galima išreikšti norimas 

emocijas ar nuotaiką. 

 

5. Scenarijaus rašymas 

Scenarijus – tai išsamus filmo aprašymas, kuriame pateikiami dialogai, scenų aprašymai ir veiksmo 

eiga. 

Rašomas pagal standartinę scenarijaus struktūrą:  

Aprašoma scena (vietos aprašymas). 

Dialogai (veikėjų pasisakymai). 

Veikėjų veiksmai ir emocijos. 

Scenarijų galima pildyti ir keisti prieš pradedant gamybą, nes jis yra pagrindinis filmo pagrindas. 
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6. Kadruotė (Storyboard) 

Kadruotė – tai vizualinis filmo planas, kuriame piešiami svarbiausi kadrai ir jų išdėstymas laike. 

Ji leidžia:  

Aiškiai matyti, kaip atrodys filmas. 

Iš anksto suplanuoti kameros kampus, kompoziciją ir scenų išdėstymą. 

Efektyviai komunikuoti idėjas tarp režisierių, animatorių ir kitų komandos narių. 

Įrankiai: piešimas ranka, skaitmeninės priemonės kaip „Storyboarder“, „Photoshop“, „Blender Grease 

Pencil“. 

 

7. Kino kalba 

Kinematografinė kalba – tai būdas, kaip vizualiai pasakojama istorija, naudojant skirtingus filmavimo 

metodus. 

Pagrindiniai elementai:  

Kamera ir kadrai – skirtingų planų naudojimas (artimas planas, vidutinis planas, tolimas planas). 

Perspektyva – kaip žiūrovas mato sceną (pvz., aukšta ar žema kamera suteikia skirtingą emocinį 

poveikį). 

Šviesa ir spalva – atmosferai sukurti naudojamos skirtingos apšvietimo technikos. 

Montažas – kaip scenos jungiamos tarpusavyje, siekiant sukurti tam tikrą ritmą ar emociją. 

 

8. Reklaminė knygutė (Pitch Bible) 

Kas tai? Reklaminė knygutė – tai dokumentas, kuriame pristatoma filmo idėja, veikėjai, pasaulis, 

kadruotės eskizai, siužeto aprašymas ir kiti vizualiniai elementai. 

Kodėl ji svarbi? Ji naudojama siekiant pristatyti projektą investuotojams, studijoms ar animacijos 

gamybos komandoms. 

Turinys:  

Projekto pavadinimas ir logotipas. 

Santrauka ir pagrindinė idėja. 

Veikėjų aprašymai ir iliustracijos. 

Aplinka ir pasaulio kūrimas. 



9 
 

Stilistikos ir spalvinės gamos pavyzdžiai. 

 

9. Koncepto dizainas 

Kas tai? Koncepto dizainas – tai pirminiai vizualiniai veikėjų, aplinkos ir objektų eskizai. 

Tikslas:  

Nustatyti stilistiką ir vizualinę kryptį. 

Sukurti pagrindinius veikėjus ir jų aplinką. 

Padėti animatoriams ir dailininkams suprasti, kaip turėtų atrodyti baigtinis filmas. 

 

10. Aplinka 

Kuriant filmo aplinką, reikia atsižvelgti į:  

Geografinę vietą – kur vyksta veiksmas? Miestas, gamta, fantastinė vietovė? 

Stilistinius sprendimus – realistiška, stilizuota ar fantastinė aplinka? 

Detalumą ir apšvietimą – kokia atmosfera bus perteikiama? 

Dažnai aplinkos dizainas padeda sustiprinti filmo pasakojimą (pvz., tamsios spalvos gali pabrėžti niūrią 

nuotaiką). 

 

11. Veikėjai 

Veikėjų dizainas apima:  

Išvaizdą – kaip atrodo veikėjai (drabužiai, kūno sudėjimas, mimikos). 

Charakterį – kokie jų bruožai, manieros ir emocijos? 

Judesį – kaip jie juda? Kiekvienas personažas gali turėti unikalų judesių stilių. 

Veikėjų anatomija ir ekspresija labai svarbios animacijoje, nes padeda perteikti emocijas. 

 

Išvada 

Paruošiamasis filmo kūrimo etapas yra itin svarbus – jis leidžia kruopščiai suplanuoti visus kūrybinius 

ir techninius aspektus, prieš pradedant faktinę animacijos gamybą. Šis etapas padeda ne tik vizualizuoti 

idėją, bet ir užtikrinti, kad visas kūrybinis procesas vyks efektyviai ir be didelių klaidų. 

💡 Sėkmingas pasiruošimas – tai pusė darbo kuriant animacinį filmą! 🎬🚀 
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Animacinio filmo gamyba 
 

Animacinio filmo gamyba – tai sudėtingas kūrybinis ir techninis procesas, kuriame naudojamos įvairios 

animacijos technikos, judesių teorijos, garso įrašymas ir vaizdo generavimas. Toliau išsamiai aptariame 

visus pagrindinius šio proceso elementus. 

 

1. Animacijos technikos 

Animacijai kurti naudojamos įvairios technikos, priklausomai nuo kūrybinio tikslo ir stilistikos: 

Rankinė animacija (Traditional Animation) – kadrai piešiami ranka, kaip klasikiniuose „Disney“ 

filmuose. 

Sustabdytas kadras (Stop Motion Animation) – naudojami fiziniai objektai, fotografuojami po truputį 

keičiant jų padėtį. 

2D skaitmeninė animacija (Digital 2D Animation) – animacija kuriama naudojant programas, tokias kaip 

„Toon Boom Harmony“, „Adobe Animate“. 

3D animacija (CGI - Computer-Generated Imagery) – naudojamos 3D modeliavimo ir animavimo 

programos, tokios kaip „Blender“, „Autodesk Maya“. 

Rotoskopija (Rotoscoping) – realių filmuotų kadrų perpiešimas ir jų pavertimas animacija. 

Motion Capture (Mocap) – aktoriaus judesiai fiksuojami ir pritaikomi skaitmeniniams veikėjams. 

 

2. Balso įrašymas 

Balsas animacijoje yra vienas svarbiausių elementų, kuris įkvėpia gyvybės veikėjams. 
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Ankstyvas įrašymas – balsai dažnai įrašomi prieš pradedant animaciją, kad animatoriai galėtų 

sinchronizuoti veikėjų lūpų judesius. 

Garsiniai efektai (Foley Sounds) – kuriami realistiški garso efektai (pvz., žingsniai, durų girgždėjimas). 

Muzika ir garso takelis – emocinei atmosferai sukurti dažnai naudojama originali muzika. 

 

3. Dvimačiai paveikslai (2D Animation) 

Piešti veikėjai – animacija gali būti piešiama ranka arba naudojant kompiuterines programas. 

Kadruotė (Frames per Second - FPS) – dažniausiai animacija kuriama naudojant 12 arba 24 kadrus per 

sekundę. 

Tweening technika – tarpinių kadrų generavimas tarp dviejų pagrindinių judesių. 

 

4. Skaitmeninė veikėjo saugykla 

Bibliotekos (Rigging Libraries) – veikėjų modeliai ir jų dalys saugomos tam tikrose programose, kad 

animatoriai galėtų jas lengvai pritaikyti. 

Rigging – procesas, kurio metu veikėjui sukuriamas skeletas, kad jį būtų galima lengviau animuoti. 

 

5. Fonai 

Ranka piešti fonai – naudojami 2D animacijose. 

3D generuoti fonai – naudojami hibridinėse animacijose. 

Dinaminių fonų naudojimas – fono animacija prideda gyvybės scenai (pvz., besikeičiantis dangus, 

judantys objektai). 

 

6. Objektų išdėstymas 

Scenų paruošimas – viskas turi būti išdėstyta taip, kad atitiktų siužetą ir kinematografinius principus. 
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Gylio efektai – naudojami perspektyvai ir 3D iliuzijai sukurti. 

 

 

7. Judesio teorija 

12 animacijos principų (sukurti Disney studijos) padeda sukurti natūralų judėjimą. 

Pagrindiniai judesiai – judėjimo greitis, greitėjimas ir lėtėjimas. 

8. Deformacijos 

Elastingumas (Squash & Stretch) – objektų suspaudimas ir ištempimas suteikia dinamiškumo. 

Perspektyvinė deformacija – kai veikėjas juda, jo dalys gali atrodyti ištemptos arba sumažėjusios. 

9. Svoris ir veiksmo laikas 

Masės pojūtis – veikėjas turi jaustis lengvas ar sunkus, priklausomai nuo jo kūno tipo ir judesio. 

Pagreitėjimas ir inercija – veiksmo pradžia ir pabaiga neturi būti staigi, viskas vyksta natūraliai. 

10. Liekamieji judesiai (Follow Through & Overlapping Action) 

Drabužių, plaukų ar uodegų judėjimas – jie juda nepriklausomai nuo pagrindinio veikėjo judesio. 

Fiziniai objektai – jeigu veikėjas sustoja, jo šalutiniai elementai (pvz., kardas) dar gali pajudėti. 

11. Pasiruošimas veiksmui (Anticipation) 

Judėjimo numatymas – veikėjas atlieka pasiruošimo veiksmą prieš pagrindinį judesį (pvz., prieš 

šokdamas jis pritupia). 

12. Vaidyba ir kūno kalba 

Gestai – rankų, veido išraiškos ir poza padeda perteikti emocijas. 

Silhuetas – aiški veikėjo forma padeda geriau suprasti jo veiksmus. 

13. Išraiškos ir lūpų sinchronizacija 

Fonetika ir judesiai – veikėjų lūpų judėjimas turi atitikti balsą. 
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Pagrindinės lūpų padėtys – „A“, „O“, „M“, „E“, „F“, „S“ ir kitos raidžių formos. 

 

 

14. Judesys ir ėjimas 

Ėjimo ciklas – veikėjo vaikščiojimas yra vienas svarbiausių elementų animacijoje. 

Greitis ir svoris – lengvi veikėjai juda greičiau nei sunkūs. 

15. Animacijos būdai 

Raktiniai kadrai (Keyframe Animation) – pagrindiniai judesio taškai animacijoje. 

Kadrų interpoliavimas (In-Betweening) – tarpinių kadrų kūrimas. 

16. Trimačiai paveikslai (3D Animation) 

Geometrija – veikėjų modeliavimas 3D erdvėje. 

Valdikliai (Rigging Controls) – naudojami skeletų valdymui. 

17. Šešėliai ir apšvietimas 

Minkštas apšvietimas – sukuria natūralų pojūtį. 

Kino apšvietimas (Three-Point Lighting) – naudojami pagrindiniai trys šviesos šaltiniai. 

18. Scenos kompozicija 

Kadruotės tipai – artimi, vidutiniai ir tolimi planai. 

Perspektyva – kaip objektai išdėstyti erdvėje. 

19. Vaizdų generavimas ir išvedimas 

Renderinimas – galutinio vaizdo generavimas. 

Eksportavimo formatai – dažniausiai naudojami MP4, MOV, PNG sekos. 

Išvada 
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Animacijos gamyba yra sudėtingas procesas, apimantis tiek meninius, tiek techninius aspektus. Norint 

sukurti kokybišką animacinį filmą, reikia išmanyti judesio teoriją, vaizdo kompoziciją, apšvietimą, 

veikėjų kūrimą ir sinchronizaciją su garsu. 

💡 Kiekvienas šių elementų prisideda prie įtikinamos ir gyvybingos animacijos kūrimo! 🚀🎬 

 

Montažas ir garsinimas animacijoje  
 

Montažas ir garsinimas yra paskutiniai animacijos kūrimo etapai, kurie padeda suteikti filmui 

išbaigtumą, ritmą ir emocinį poveikį. Šis procesas apima vaizdų komponavimą, vizualiuosius efektus, 

garso takelio kūrimą ir galutinį montažą. 

 

1. Animacijos komponavimas 🎞️ 

 

Animacijos komponavimas (Compositing) – tai procesas, kuriame visi vizualiniai elementai (veikėjai, 

fonai, specialieji efektai) sujungiami į galutinę animacinę sceną. 

✅ Pagrindiniai komponavimo aspektai: 

Sluoksniavimas (Layering) – veikėjai, fonai, šešėliai ir efektai yra atskiruose sluoksniuose, kurie vėliau 

sujungiami. 

Spalvų koregavimas – užtikrina, kad visi animacijos elementai turėtų vienodą apšvietimą ir atitiktų 

bendrą stilistiką. 

Šviesos ir šešėlių derinimas – suteikia scenai realistiškumo. 

Gylio efektai (Depth of Field) – imituoja kameros fokusavimą tam tikroje vietoje, paliekant kitus 

elementus „išsiliejusius“. 

🔧 Naudojamos programos: 

„Adobe After Effects“ (2D animacijos efektams ir komponavimui) 
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„Blender“ (3D animacijos ir vizualiniams efektams) 

„Nuke“ (profesionalus VFX komponavimo įrankis) 

 

2. CGI komponavimas 🖥️ 

CGI (Computer-Generated Imagery) komponavimas – tai 3D modelių, tekstūrų ir efektų sujungimas į 

vieningą animacinį filmą. 

✅ Pagrindiniai CGI komponavimo etapai: 

Modeliavimas (Modeling) – veikėjų, aplinkos ir objektų kūrimas. 

Tekstūravimas (Texturing) – medžiagų ir spalvų pritaikymas 3D objektams. 

Apšvietimas (Lighting) – scenos apšvietimo kūrimas. 

Renderinimas (Rendering) – galutinio vaizdo sugeneravimas naudojant CGI programinę įrangą. 

🔧 Naudojamos programos: 

„Blender“ (nemokama ir populiari CGI kūrimo programa) 

„Autodesk Maya“ (naudojama profesionaliose animacijos studijose) 

„Cinema 4D“ (naudojama judančių grafikų kūrimui) 

 

3. Vizualieji efektai (VFX – Visual Effects) 💥 

Vizualieji efektai yra svarbi animacijos dalis, leidžianti pridėti dinamiškų elementų, kurie nebuvo 

sukurti rankiniu būdu. 

✅ Vizualinių efektų tipai: 

Dalelių efektai (Particle Effects) – naudojami dūmams, ugniai, lietui, sprogimams. 

Skysčių simuliacija (Fluid Simulation) – naudojama vandens, lavos ar kitų skysčių animacijai. 
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Fizikos simuliacija (Physics Simulation) – objektų kritimo, susidūrimų ir kitų fizinių judesių kūrimas. 

3D kamera ir judesio sekimas (Motion Tracking) – naudojama 3D elementams integruoti į filmuotą 

medžiagą. 

 

🔧 Naudojamos programos: 

„Houdini“ (pažangiausia VFX kūrimo programa) 

„Adobe After Effects“ (paprastesni vizualieji efektai) 

„Blender“ (nemokami vizualiniai efektai) 

 

4. Garso takelio gamyba 🎵 

Garso takelis suteikia animacijai atmosferą ir emocinį gilumą. 

✅ Garso takelio kūrimo elementai: 

Fono muzika – padeda sukurti filmo nuotaiką (dramatinė, linksma, įtempta). 

Garso efektai (Sound Effects - SFX) – veikėjų žingsniai, durų girgždėjimas, vėjo švilpimas. 

Dialogai – veikėjų balsai, įrašyti profesionalių aktorių arba DI generuoti balsai. 

🔧 Naudojamos programos: 

„Adobe Audition“ (garsui redaguoti ir miksuoti) 

„Audacity“ (nemokama alternatyva garso įrašymui ir efektams) 

„Reaper“ (profesionalus garso takelių redagavimo įrankis) 

 

5. Galutinis garsinimas 🎙️ 

Galutiniame garsinimo etape visi garso sluoksniai sujungiami į vieną vientisą garso takelį. 
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✅ Garsinimo etapai: 

Garso miksavimas (Sound Mixing) – balansas tarp dialogų, muzikos ir garso efektų. 

Garso masterizavimas (Sound Mastering) – užtikrinama, kad garsas būtų aiškus ir vienodai girdimas 

skirtingose sistemose. 

Sinchronizacija su animacija – užtikrinama, kad veiksmai ir garsai būtų laiku suderinti. 

🔧 Naudojamos programos: 

„Pro Tools“ (profesionali garso gamyba) 

„Logic Pro X“ (muzikai ir garso dizainui kurti) 

 

6. Animacijos montažas: teorija ir praktika 🎞️ 

Montažas yra procesas, kuriame visos animacijos scenos sujungiamos į galutinį filmą. 

✅ Animacijos montažo principai: 

Teminis montažas – scenos keičiamos pagal temą ar emociją. 

Ritminis montažas – montažo greitis derinamas prie muzikos ar veiksmo intensyvumo. 

Erzinimo metodas (Anticipation Cuts) – ankstesnės scenos rodo, kas įvyks vėliau, taip sukuriant 

įtampą. 

Jump Cut (Šuolio montažas) – naudojamas greitam veiksmo perjungimui. 

🔧 Naudojamos programos: 

„Adobe Premiere Pro“ (profesionalus montažo įrankis) 

„DaVinci Resolve“ (nemokama alternatyva spalvų korekcijai ir montažui) 

„Final Cut Pro“ (Apple ekosistemos naudotojams) 
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Išvada 🎬 

Montažas ir garsinimas yra paskutiniai, bet labai svarbūs animacijos kūrimo etapai. Jie suteikia 

animaciniam filmui dynamiką, vientisumą, emocinį poveikį ir vizualinį tikroviškumą. 

✅ Pagrindiniai žingsniai: 

✔ Animacijos komponavimas – veikėjų ir fonų sujungimas. 

✔ CGI komponavimas – 3D modelių, tekstūrų ir apšvietimo suderinimas. 

✔ Vizualieji efektai – dūmai, šviesos, judesio efektai. 

✔ Garso takelio gamyba – muzika, efektai, balsai. 

✔ Galutinis garsinimas – visų garsų miksavimas ir sinchronizacija. 

✔ Animacijos montažas – galutinė scenų ir vaizdų jungtis. 

🔹 Rezultatas: vientisa, įtikinama animacija su profesionaliai apdorotu garsu ir efektais. 🎥🎶🚀 

Darbo pristatymas animacijoje 
 

Kai animacinis filmas ar projektas yra baigtas, svarbu tinkamai jį pristatyti, reklamuoti ir pateikti savo 

paslaugas potencialiems klientams ar auditorijai. Šis etapas gali nulemti, kiek žmonių pamatys darbą ir 

kaip jis bus vertinamas. 

 

1. Reklama 📣 

Reklama yra esminis elementas, padedantis pasiekti auditoriją, sukurti susidomėjimą ir pritraukti 

žiūrovus ar investuotojus. 

✅ Reklamos būdai: 

a) Teaseriai ir anonsai (Trailers & Teasers) 

Trumpi vaizdo įrašai (15–60 sek.), kuriuose pateikiamos įdomiausios filmo scenos, siekiant sukelti 

smalsumą. 

YouTube, socialinių tinklų reklamos, kino teatruose rodomi anonsai. 

b) Plakatai ir vizualinė reklama 

Animacinio filmo plakatas – svarbus rinkodaros elementas, kuriame pateikiamas pagrindinis veikėjas, 

stilistika ir išleidimo data. 
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Socialinių tinklų vizualai – kviečiantys į peržiūras ar skatinantys dalintis filmu. 

c) Socialinės medijos kampanijos 

Instagram, TikTok, Facebook, Twitter/X – naudojami filmo iškarpos, užkulisiai, veikėjų pristatymai, 

interaktyvūs postai. 

Hashtag’ai ir iššūkiai – skatina auditoriją įsitraukti (pvz., fanų kūryba, remiksai, reakcijos). 

d) Prekiniai ženklai ir partnerystės 

Jei animacinis projektas yra didesnio masto, galima bendradarbiauti su įmonėmis, turinčiomis susijusią 

auditoriją (pvz., žaislų gamintojais, edukacinėmis platformomis). 

e) Premjeros ir festivalių dalyvavimas 

Animaciniai projektai gali būti pristatomi festivaliuose, tokiuose kaip Annecy International Animation 

Festival, Animafest Zagreb, Ottawa International Animation Festival. 

Specialios peržiūros kino teatruose ar internetinėse platformose padeda pritraukti auditoriją. 

 

2. Savo paslaugų pasiūlymas 🎨🎥 

Jeigu siekiama pritraukti klientus ar darbdavius, svarbu profesionaliai pristatyti savo animacijos darbą. 

✅ Pagrindiniai būdai, kaip efektyviai pasiūlyti savo paslaugas: 

a) Portfolio ir demoreel 

Portfolio svetainė – tai asmeninis puslapis, kuriame pateikiami geriausi animacijos darbai, projektai, 

aprašymai. 

Demoreel (Showreel) – trumpas (30–90 sek.) vaizdo įrašas, kuriame pateikiami įspūdingiausi animacijos 

projektai. 

🔧 Svetainės kūrimo įrankiai: 

„Behance“, „ArtStation“ – populiarios kūrybinės platformos. 

„Wix“, „Squarespace“, „WordPress“ – svetainių kūrimo įrankiai be programavimo. 

b) Paslaugų siūlymas laisvai samdomiems projektams 

Freelancer platformos: „Upwork“, „Fiverr“, „PeoplePerHour“, „Freelancer“. 

Bendravimas su studijomis – siųsti savo portfolio į animacijos studijas, kurios nuolat ieško talentų. 

c) Profesionalūs kontaktai ir tinklaveika 

LinkedIn profilis – padeda susisiekti su animacijos industrijos specialistais. 

Animacijos forumai ir bendruomenės – „CG Society“, „Blender Artists“, „Reddit r/animation“. 
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d) Individualūs projektai ir edukaciniai kursai 

YouTube kanalas arba Patreon – kurti savo animacinius projektus, mokyti kitus, pritraukti auditoriją. 

Mokymų organizavimas – siūlyti edukacinius kursus apie animaciją („Skillshare“, „Udemy“, 

„Domestika“). 

 

Išvada 🏆 

🔹 Darbo pristatymas animacijoje yra ne tik kūrybinis, bet ir strateginis procesas. 

🔹 Tinkama reklama gali sustiprinti filmo populiarumą, o gerai parengtas paslaugų pasiūlymas padeda 

pritraukti klientus ar darbdavius. 

🔹 Naudojant socialinius tinklus, portfolio, festivalinius pristatymus ir tinklaveiką, animacijos kūrėjai 

gali išpopuliarinti savo darbus ir įsitvirtinti industrijoje. 

✨ Sėkmingai pristatykite savo kūrybą ir pasiekite platesnę auditoriją! 🚀🎬 

 

Savikontrolės klausimai 
 

Animacijos istorijos testas: 30 klausimų su trimis atsakymų variantais 

Kiekviename klausime pateikti trys atsakymo variantai, vienas iš jų yra teisingas. 

 

1. Kas laikomas pirmuoju animacijos išradėju? 

A) Walt Disney 

B) Émile Reynaud ✅ 

C) John Lasseter 

 

2. Kokį animacijos prietaisą sukūrė Émile Reynaud? 

A) Phenakistoscope 

B) Praxinoscope ✅ 

C) Zoetrope 

 

3. Kuris iš šių optinių žaislų nebuvo naudojamas animacijos iliuzijai sukurti? 
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A) Thaumatrope 

B) Kaleidoskopas ✅ 

C) Zoetrope 

 

4. Kada buvo sukurta pirmoji projekcinė animacija „Pantomimes Lumineuses“? 

A) 1892 m. ✅ 

B) 1914 m. 

C) 1937 m. 

 

5. Kas sukūrė pirmąją animuotą filmuotą sceną „The Enchanted Drawing“? 

A) Walt Disney 

B) J. Stuart Blackton ✅ 

C) Winsor McCay 

 

6. Kaip vadinasi pirmasis animacinis filmas, kuriame animuotas veikėjas sąveikavo su animatoriumi? 

A) „Gertie the Dinosaur“ ✅ 

B) „Little Nemo“ 

C) „Steamboat Willie“ 

 

7. Kas laikomas pirmuoju sinchronizuoto garso animaciniu filmu? 

A) „Steamboat Willie“ ✅ 

B) „Fantasia“ 

C) „Snieguolė ir septyni nykštukai“ 

 

8. Kada buvo išleistas pirmasis pilnametražis animacinis filmas? 

A) 1928 m. 

B) 1937 m. ✅ 

C) 1955 m. 

 

9. Koks buvo pirmasis pilnametražis animacinis filmas? 
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A) „Pinokis“ 

B) „Dumbo“ 

C) „Snieguolė ir septyni nykštukai“ ✅ 

 

10. Kokia kompanija sukūrė animacinius serialus „Looney Tunes“ ir „Merrie Melodies“? 

A) Warner Bros. ✅ 

B) Walt Disney 

C) Pixar 

 

11. Kokia buvo pirmoji spalvota animacija? 

A) „Fantasia“ 

B) „Flowers and Trees“ ✅ 

C) „Steamboat Willie“ 

 

12. Kas sukūrė pirmąjį televizijos animacinį serialą „The Flintstones“? 

A) Hanna-Barbera ✅ 

B) Walt Disney 

C) Pixar 

 

13. Kada prasidėjo televizijos animacijos era? 

A) 1920 m. 

B) 1960 m. ✅ 

C) 1980 m. 

 

14. Kuri Japonijos animacijos studija pradėjo kurti anime 1956 m.? 

A) Studio Ghibli 

B) Toei Animation ✅ 

C) Sunrise 

 

15. Kada buvo išleistas pirmasis CGI pilnametražis animacinis filmas? 
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A) 1985 m. 

B) 1995 m. ✅ 

C) 2005 m. 

 

16. Koks buvo pirmasis pilnametražis CGI animacinis filmas? 

A) „Shrek“ 

B) „Finding Nemo“ 

C) „Toy Story“ ✅ 

 

17. Kokia studija sukūrė „Toy Story“? 

A) DreamWorks 

B) Pixar ✅ 

C) Warner Bros. 

 

18. Kokia animacijos studija sukūrė „Shrek“? 

A) Pixar 

B) DreamWorks ✅ 

C) Disney 

 

19. Kokia programinė įranga dažniausiai naudojama 3D animacijai? 

A) Adobe Photoshop 

B) Autodesk Maya ✅ 

C) Toon Boom Harmony 

 

20. Kokia animacijos technika naudojama „Coraline“ filme? 

A) 2D animacija 

B) Stop-motion ✅ 

C) CGI animacija 

 

21. Kuris animatorius laikomas vienu iš anime industrijos pradininkų? 
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A) Hayao Miyazaki ✅ 

B) Osamu Tezuka 

C) Isao Takahata 

 

22. Koks buvo pirmasis „Studio Ghibli“ sukurtas animacinis filmas? 

A) „Mano kaimynas Totoro“ 

B) „Laputa: Castle in the Sky“ ✅ 

C) „Princesė Mononokė“ 

 

23. Kokia animacijos forma naudoja žmogaus judesių fiksavimą ir perkėlimą į animuotus veikėjus? 

A) Stop-motion 

B) Rotoscoping 

C) Motion capture ✅ 

 

24. Kokia animacijos studija buvo įkurta Hayao Miyazaki? 

A) Sunrise 

B) Studio Ghibli ✅ 

C) Toei Animation 

 

25. Kokia animacijos technika naudojama filmams, kuriuose veikėjų judesiai piešiami iš tikrų filmuotų 

kadrų? 

A) CGI 

B) Rotoscoping ✅ 

C) Stop-motion 

 

26. Koks buvo pirmasis animacinis filmas, laimėjęs „Oskarą“ už geriausią animacinį filmą? 

A) „Toy Story“ 

B) „Shrek“ ✅ 

C) „The Lion King“ 

 

27. Kuri programa dažniausiai naudojama 2D animacijai? 
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A) Blender 

B) Toon Boom Harmony ✅ 

C) Autodesk Maya 

 

28. Kokia technika dažniausiai naudojama šiuolaikiniuose animaciniuose žaidimuose? 

A) Stop-motion 

B) CGI ✅ 

C) Rotoscoping 

 

29. Koks buvo pirmasis animacinis filmas su stereoskopiniu 3D efektu? 

A) „Avatar“ 

B) „Chicken Little“ ✅ 

C) „Finding Nemo“ 

 

30. Kokie įrankiai naudojami realaus laiko animacijai kurti? 

A) Adobe Photoshop 

B) Unreal Engine ✅ 

C) Final Cut Pro 

 

Tai yra 30 klausimų testas apie animacijos istoriją, kuris gali būti naudojamas mokiniams arba 

savarankiškam žinių patikrinimui. 🏆🎬 

 

Pamokų planas (10 pamokų) I variantas 
 

 

Pamokų ciklas: Animacijos istorija 🎬 

Šis 10 pamokų planas supažindins mokinius su animacijos istorija – nuo senovės optinių iliuzijų iki šiuolaikinių 

skaitmeninių technologijų. Pamokos struktūruotos taip, kad mokiniai įgytų teorinių žinių, analizuotų pavyzdžius 

ir praktiškai išbandytų kai kurias animacijos technikas. 

 

1 PAMOKA: Įvadas į animacijos istoriją 
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Tikslas: Supažindinti mokinius su animacijos sąvoka ir jos raida. 

✅ Veiklos: 

Diskusija: Kas yra animacija? Kokias animacijas mėgsta mokiniai? 

Paskaita apie pirmuosius animacijos bandymus ir jos reikšmę mene ir kultūroje. 

Vaizdo peržiūra: trumpi dokumentiniai filmai apie animacijos istoriją. 

Kūrybinė užduotis: nupiešti paprastą judesio iliuziją (pvz., per kelių kadrų piešinius). 

🎯 Rezultatas: Mokiniai supranta animacijos sampratą ir jos atsiradimo priežastis. 

 

2 PAMOKA: Optiniai žaislai ir pirmieji judesio eksperimentai 

Tikslas: Išnagrinėti XIX a. optinius žaislus ir jų poveikį animacijos vystymuisi. 

✅ Veiklos: 

Paskaita apie Thaumatrope, Zoetrope, Phenakistoscope ir Praxinoscope. 

Demonstracija: kaip veikia šie optiniai žaislai. 

Praktinė užduotis: mokiniai pasigamina savo Thaumatrope arba Zoetrope juostelę. 

Diskusija: Kodėl šie išradimai buvo svarbūs? 

🎯 Rezultatas: Mokiniai supranta, kaip žmonės bandė kurti judesio iliuziją prieš kino atsiradimą. 

 

3 PAMOKA: Pirmieji animaciniai filmai 

Tikslas: Aptarti, kaip atsirado pirmieji animaciniai filmai ir kokie jų kūrėjai buvo svarbiausi. 

✅ Veiklos: 

Paskaita apie Émile Reynaud, J. Stuart Blackton, Winsor McCay ir jų darbus. 

Peržiūra: „Gertie the Dinosaur“ (1914) ir kitų ankstyvųjų animacijų. 

Diskusija: Kokios šių animacijų ypatybės? Kaip jos skiriasi nuo šiandieninės animacijos? 

Praktinė užduotis: sukurti paprastą flipbook (knygelės animaciją). 

🎯 Rezultatas: Mokiniai supranta pirmųjų animacinių filmų svarbą ir išbando ankstyvąją animacijos techniką. 

 

4 PAMOKA: Holivudo aukso amžius ir garsioji animacija (1920–1950 m.) 

Tikslas: Išnagrinėti, kaip Holivudas padarė įtaką animacijos plėtrai. 
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✅ Veiklos: 

Paskaita apie Walt Disney, Warner Bros. ir MGM animaciją. 

Peržiūra: „Steamboat Willie“ (1928), „Looney Tunes“, „Tom & Jerry“. 

Diskusija: Kaip garsas ir spalvos pakeitė animaciją? 

Praktinė užduotis: sukurti trumpą animacijos siužetą remiantis klasikiniais animacijos principais. 

🎯 Rezultatas: Mokiniai susipažįsta su garsiojo Holivudo animacijos laikotarpiu ir supranta, kaip keitėsi 

animacijos stilius. 

 

5 PAMOKA: Pokario animacija ir televizijos revoliucija (1950–1980 m.) 

Tikslas: Išnagrinėti, kaip televizija pakeitė animacijos pramonę. 

✅ Veiklos: 

Paskaita apie „The Flintstones“, „Scooby-Doo“ ir anime atsiradimą. 

Peržiūra: klasikinių televizijos animacinių serialų ištraukos. 

Diskusija: Kaip televizijos animacija skiriasi nuo kino animacijos? 

Praktinė užduotis: mokiniai sukuria savo animacinio serialo koncepciją. 

🎯 Rezultatas: Mokiniai supranta, kaip televizija pakeitė animacijos industriją ir kokia buvo anime įtaka. 

 

6 PAMOKA: Skaitmeninės animacijos atsiradimas (1980–dabar) 

Tikslas: Aptarti CGI animacijos atsiradimą ir jos poveikį. 

✅ Veiklos: 

Paskaita apie CGI plėtrą, „Toy Story“ (1995) ir Pixar studiją. 

Peržiūra: CGI animacijos evoliucija. 

Diskusija: Kokie CGI animacijos privalumai ir trūkumai? 

Praktinė užduotis: mokiniai kuria paprastą 3D modelį „Blender“ programoje. 

🎯 Rezultatas: Mokiniai supranta CGI technologiją ir išbando paprastus 3D modeliavimo įrankius. 

 

7 PAMOKA: Animacijos technikos ir eksperimentinė animacija 

Tikslas: Išnagrinėti skirtingas animacijos technikas. 
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✅ Veiklos: 

Paskaita apie stop-motion, rotoskopiją, eksperimentinę animaciją. 

Peržiūra: „The Nightmare Before Christmas“, „A Scanner Darkly“. 

Praktinė užduotis: sukurti stop-motion animaciją naudojant telefoną ir plastiliną. 

🎯 Rezultatas: Mokiniai susipažįsta su įvairiomis animacijos technikomis ir praktiškai išbando stop-motion 

animaciją. 

 

8 PAMOKA: Animacija žaidimuose ir VR pasaulyje 

Tikslas: Suprasti, kaip animacija naudojama žaidimuose ir VR. 

✅ Veiklos: 

Paskaita apie „Unreal Engine“, „Unity“ ir VR animaciją. 

Diskusija: Kuo skiriasi filmų ir žaidimų animacija? 

Praktinė užduotis: mokiniai sukuria paprastą animuotą veikėją Unity programoje. 

🎯 Rezultatas: Mokiniai susipažįsta su interaktyvios animacijos pagrindais. 

 

9 PAMOKA: Animacijos ateitis ir dirbtinis intelektas 

Tikslas: Aptarti naujausias animacijos tendencijas. 

✅ Veiklos: 

Paskaita apie DI kuriamą animaciją ir automatizuotus įrankius. 

Diskusija: Kokie yra DI privalumai ir iššūkiai animacijoje? 

Praktinė užduotis: mokiniai išbando dirbtinio intelekto generuotą animaciją (pvz., „Runway ML“). 

🎯 Rezultatas: Mokiniai supranta, kaip DI keičia animacijos industriją. 

 

10 PAMOKA: Animacijos istorijos testas ir refleksija 

Tikslas: Apibendrinti įgytas žinias. 

✅ Veiklos: 

Testas apie animacijos istoriją (30 klausimų). 

Grupinė diskusija: Kokia animacijos technika mokiniams patiko labiausiai? 
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Kūrybinė užduotis: mokiniai kuria animacijos ateities prognozes. 

🎯 Rezultatas: Mokiniai įsivertina savo žinias ir aptaria animacijos ateitį. 

 

💡 Šis pamokų ciklas leidžia mokiniams ne tik įgyti teorinių žinių, bet ir praktiškai išbandyti animacijos kūrimo 

būdus! 🚀🎬 

 

Pamokų planas II variantas 
 

Pamokų ciklas: Animacijos istorija 

Šis 10 pamokų planas padės mokiniams susipažinti su animacijos istorija, jos technologine evoliucija ir 

praktiniais elementais. 

 

1 PAMOKA: ĮVADAS Į ANIMACIJOS ISTORIJĄ 🎬 

Tikslas: Supažindinti mokinius su animacijos samprata, jos reikšme ir istorine raida. 

✅ Veiklos: 

Diskusija: Ką mokiniai žino apie animaciją? 

Trumpo dokumentinio filmo peržiūra apie animacijos kilmę. 

Užduotis: Sudaryti animacijos istorijos laiko juostą. 

📌 Rezultatas: Mokiniai supras animacijos atsiradimo priežastis ir jos reikšmę kino pramonėje. 

 

2 PAMOKA: ANKSTYVIEJI ANIMACIJOS EKSPERIMENTAI 🕰️ 

Tikslas: Supažindinti su optiniais žaislais, kurie buvo animacijos pirmtakai. 

✅ Veiklos: 

Optinių žaislų (Thaumatrope, Zoetrope, Phenakistoscope) pristatymas ir jų veikimo principai. 

Praktinė užduotis: Kiekvienas mokinys sukuria savo „Thaumatrope“. 

📌 Rezultatas: Mokiniai supras, kaip kuriamas judėjimo iliuzijos efektas. 

 

3 PAMOKA: PIRMIEJI ANIMACINIAI FILMAI 🎞️ 
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Tikslas: Išnagrinėti pirmuosius animacinius filmus ir jų kūrėjus. 

✅ Veiklos: 

Peržiūra: „Gertie the Dinosaur“ (Winsor McCay, 1914 m.). 

Klasės diskusija apie filmų inovacijas. 

Užduotis: Palyginti 1910–1920 m. animacijas su šiandienine. 

📌 Rezultatas: Mokiniai supras, kaip vystėsi pirmosios animacijos technikos. 

 

4 PAMOKA: HOLIVUDO AUKSO AMŽIUS IR „DISNEY“ REVOLIUCIJA ✨ 

Tikslas: Supažindinti su Walt Disney indėliu animacijos industrijoje. 

✅ Veiklos: 

„Steamboat Willie“ (1928 m.) analizė: pirmoji animacija su sinchronizuotu garsu. 

Diskusija apie pirmąjį pilnametražį filmą „Snieguolė ir septyni nykštukai“ (1937 m.). 

Praktinė užduotis: Sukurti trumpą animacijos idėją, remiantis Disney stilistika. 

📌 Rezultatas: Mokiniai supras, kaip Disney sukūrė animacijos standartus. 

 

5 PAMOKA: TELEVIZINĖ ANIMACIJA IR ANIME KILMĖ 📺 

Tikslas: Išanalizuoti televizijos animacijos pradžią ir anime žanro kilmę. 

✅ Veiklos: 

„The Flintstones“ (1960 m.) ir pirmasis anime „Astro Boy“ (1963 m.) palyginimas. 

Diskusija apie anime skirtumus nuo Vakarų animacijos. 

Užduotis: Sukurti anime veikėjo eskizą. 

📌 Rezultatas: Mokiniai supras skirtingų regionų animacijos stilius ir jų raidą. 

 

6 PAMOKA: CGI REVOLIUCIJA IR SKAITMENINĖ ANIMACIJA 🖥️ 

Tikslas: Supažindinti su CGI animacijos kilme ir jos poveikiu pramonei. 

✅ Veiklos: 

„Toy Story“ (1995 m.) peržiūros fragmentai ir aptarimas. 

Diskusija apie CGI technologijos pranašumus ir trūkumus. 
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Praktinė užduotis: Animacijos scenos kūrimas naudojant „Blender“ arba „Krita“. 

📌 Rezultatas: Mokiniai sužinos, kaip CGI pakeitė animacijos industriją. 

 

7 PAMOKA: ANIMACIJOS PRINCIPAI IR TECHNIKOS 🎨 

Tikslas: Supažindinti su 12 animacijos principų ir jų taikymu. 

✅ Veiklos: 

12 Disney animacijos principų demonstracija (Squash & Stretch, Anticipation ir kt.). 

Klasės praktika: Pieštinės animacijos sukūrimas. 

Užduotis: Sukurti 3 sekundžių animuotą veikėjo judesį. 

📌 Rezultatas: Mokiniai pritaikys animacijos principus praktikoje. 

 

8 PAMOKA: MODERNI ANIMACIJA – „PIXAR“, „DREAMWORKS“ IR ANIMACIJA 

ŽAIDIMUOSE 🎮 

Tikslas: Aptarti, kaip animacija pritaikoma kino ir žaidimų industrijoje. 

✅ Veiklos: 

Diskusija apie „Pixar“ ir „DreamWorks“ skirtumus. 

3D animacijos vaidmuo žaidimuose („Unreal Engine“, „Unity“ demonstracija). 

Praktinė užduotis: 3D veikėjo modelio kūrimas arba animacijos efektų eksperimentai. 

📌 Rezultatas: Mokiniai supras, kaip animacija naudojama žaidimuose ir kine. 

 

9 PAMOKA: ANIMACIJOS MONTAŽAS IR GARSINIMAS 🔊 

Tikslas: Išmokti, kaip animacijos vaizdai ir garsai sujungiami į vientisą kūrinį. 

✅ Veiklos: 

Garsinio sinchronizavimo principų aptarimas. 

Praktinė užduotis: Garso takelio kūrimas paprastai animacijai. 

Video montažo demonstracija naudojant „Adobe After Effects“ ar „DaVinci Resolve“. 

📌 Rezultatas: Mokiniai išmoks animacijos ir garso sinchronizavimo pagrindus. 
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10 PAMOKA: ANIMACIJOS ATEITIS – VIRTUALI REALYBĖ IR DI NAUDOJIMAS 🚀 

Tikslas: Aptarti, kaip naujos technologijos keičia animacijos pramonę. 

✅ Veiklos: 

Virtualios realybės ir DI naudojimo animacijoje demonstracija („Oculus Quest“, „AI Animation“ 

įrankiai). 

Diskusija: Kaip dirbtinis intelektas keičia animacijos kūrimą? 

Kūrybinė užduotis: Klasės komandos sukuria animacijos idėją, naudojant DI. 

📌 Rezultatas: Mokiniai supras, kokia gali būti animacijos ateitis. 

 

Baigiamasis projektas 🎬 

Po 10 pamokų mokiniai sukurs trumpą animaciją (5–10 sek.), pritaikydami išmoktus principus. Tai gali 

būti 2D ar 3D animacija, GIF arba paprasta animacija su garsais. 

📌 Pabaigos refleksija: Aptariamos patirtys, su kokiais iššūkiais susidūrė mokiniai ir ką jie išmoko. 

 

Išvada 

Šios 10 pamokų padės giliau suprasti animacijos istoriją, technologinę raidą ir praktinius animacijos 

kūrimo aspektus. 🚀🎨 

 

Praktiniai užsiėmimai pamokų metu  
 

10 įdomių praktinių užsiėmimų animacijos istorijos temai 🎬🎨 

Šie praktiniai užsiėmimai padės mokiniams aktyviai įsitraukti į animacijos istorijos tyrinėjimą ir 

kūrybinį procesą. 

 

1. Sukurk savo „Thaumatrope“ 🌀 

📌 Tikslas: Suprasti, kaip optiniai žaislai padėjo sukurti pirmąsias animacijas. 

🔹 Priemonės: Popierius, siūlas arba pagaliukai, pieštukai. 

🔹 Veikla: 

Mokiniai sukuria dviejų vaizdų diskelį, kuris suktas sukuria judėjimo iliuziją (pvz., paukštis ir narvas). 
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Diskutuojama, kaip mūsų akys apdoroja vaizdus ir sukuria judesio iliuziją. 

✅ Rezultatas: Mokiniai supranta „Persistence of Vision“ principą, kuris yra animacijos pagrindas. 

 

2. Pieštinė animacija: „Flipbook“ kūrimas 📖 

📌 Tikslas: Išmokti pagrindinius animacijos principus ir sukurti paprastą animuotą sceną. 

🔹 Priemonės: Mažos popieriaus kortelės, pieštukai, segtuvai. 

🔹 Veikla: 

Kiekvienas mokinys nupiešia veiksmų seką (pvz., šokantį veikėją, šokinėjantį kamuolį) ant atskirų 

puslapių. 

Sukurta animacija peržiūrima greitai verčiant lapus. 

✅ Rezultatas: Mokiniai supranta pagrindinius judesio kūrimo principus animacijoje. 

 

3. Senosios animacijos atkūrimas: „Gertie the Dinosaur“ scena 🦕 

📌 Tikslas: Atkurti vieną iš pirmųjų animacinių filmų. 

🔹 Priemonės: Popierius, „Blender Grease Pencil“ arba „Krita“. 

🔹 Veikla: 

Mokiniai analizuoja „Gertie the Dinosaur“ (1914 m.) ir bando atkurti trumpą veikėjo judesį. 

Galima naudoti „Stop-motion“ arba 2D pieštinę animaciją. 

✅ Rezultatas: Mokiniai mokosi imituoti klasikinius animacijos metodus. 

 

4. Walt Disney animacijos principų pritaikymas 🎭 

📌 Tikslas: Išmokti ir pritaikyti 12 animacijos principų. 

🔹 Priemonės: Kompiuteris su „Blender“ arba „Adobe Animate“, popierius eskizams. 

🔹 Veikla: 

Mokiniai pasirenka vieną principą (pvz., „Squash & Stretch“, „Anticipation“) ir sukuria trumpą 

animaciją. 

Pavyzdys: Kamuolio atšokimas su „Squash & Stretch“ efektu. 

✅ Rezultatas: Mokiniai supranta, kaip animacija tampa natūralesnė ir ekspresyvesnė. 
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5. Klasikinio animacinio personažo kūrimas ✍️ 

📌 Tikslas: Išanalizuoti ir sukurti personažą pagal XX a. animacijos stilių. 

🔹 Priemonės: Popierius, „Procreate“, „Photoshop“ ar kiti piešimo įrankiai. 

🔹 Veikla: 

Mokiniai pasirenka vieną klasikinį animacijos stilių („Disney“, „Looney Tunes“, „Anime“). 

Sukuria personažą, laikydamiesi pasirinkto stiliaus. 

✅ Rezultatas: Mokiniai supranta, kaip vizualiniai elementai apibrėžia animacijos stilių. 

 

6. 3D animacijos eksperimentas su „Blender“ 🖥️ 

📌 Tikslas: Susipažinti su kompiuterinės animacijos pagrindais. 

🔹 Priemonės: „Blender“, internetiniai mokomieji vadovai. 

🔹 Veikla: 

Mokiniai naudoja „Blender“ ir sukuria paprastą animuotą objektą (pvz., judantį kubą ar rutulį). 

Išmoksta naudoti pagrindinius raktinius kadrus (Keyframes). 

✅ Rezultatas: Mokiniai supranta 3D animacijos kūrimo procesą ir jos skirtumus nuo 2D animacijos. 

 

7. Garso ir lūpų sinchronizavimo dirbtuvės 🎙️ 

📌 Tikslas: Išmokti sinchronizuoti veikėjo lūpas su balsu. 

🔹 Priemonės: „Adobe Character Animator“, „Audacity“. 

🔹 Veikla: 

Mokiniai pasirenka trumpą frazę ir įrašo savo balsą. 

Sukuria lūpų judesius, atitinkančius garsą. 

✅ Rezultatas: Mokiniai supranta, kaip svarbu tiksliai pritaikyti garsą prie animacijos. 

 

8. „Stop-Motion“ animacijos eksperimentas 🎭 

📌 Tikslas: Praktikuoti „Stop-motion“ techniką. 

🔹 Priemonės: Plastilinas, figūrėlės, kamera ar telefonas su „Stop Motion Studio“. 

🔹 Veikla: 

Mokiniai sukuria trumpą „Stop-motion“ sceną (pvz., judantis personažas, interaktyvus objektas). 
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Fotografuoja kadrus, sujungia juos į animaciją. 

✅ Rezultatas: Mokiniai išmoks naudoti „Stop-motion“ techniką, supras kadrų sekos svarbą. 

 

9. Trumpas animacinis filmas su montažu 🎞️ 

📌 Tikslas: Suderinti animaciją su montažu ir muzika. 

🔹 Priemonės: „Adobe Premiere Pro“, „DaVinci Resolve“, nemokamos montažo programos. 

🔹 Veikla: 

Mokiniai animuoja trumpą sceną (5–10 sek.) ir įkelia ją į montažo programą. 

Prideda garsą, muziką, efektus. 

✅ Rezultatas: Mokiniai išmoks montažo pagrindus ir supras, kaip suderinti vaizdą su garsu. 

 

10. Virtualios realybės ir dirbtinio intelekto animacijos ateitis 🦕 

📌 Tikslas: Ištirti, kaip DI ir VR keičia animaciją. 

🔹 Priemonės: „Unreal Engine“, „Runway ML“ arba DI animacijos įrankiai. 

🔹 Veikla: 

Mokiniai eksperimentuoja su DI generuojamomis animacijomis. 

Aptaria, kaip DI gali pakeisti animacijos industriją. 

✅ Rezultatas: Mokiniai supras, kokios yra animacijos ateities technologijos ir jų galimybės. 

 

Išvada 

💡 Šie 10 praktinių užsiėmimų padės mokinams ne tik suprasti animacijos istoriją, bet ir aktyviai 

išbandyti įvairias jos technikas, nuo rankinės animacijos iki CGI ir DI įrankių naudojimo! 🚀 
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Klausimai – atsakymai 
  

Blender 

Kaip sukurti paprastą kamuoliuko animaciją su „Blender“? 🏀🎬 

Šiame vadove paaiškinsiu, kaip „Blender“ sukurti paprastą kamuoliuko šokinėjimo animaciją, 

naudojant pagrindinius animacijos įrankius. 

 

1⃣ Nustatykite darbo aplinką 

✅ Atidarykite „Blender“ ir pasirinkite General projektą. 

✅ Ištrinkite pradinį kubą (X klavišas → Delete). 

 

2⃣ Sukurkite kamuoliuką 

✅ Pridėkite sferą: 

Paspauskite Shift + A → Mesh → UV Sphere. 

Kad būtų lygesnė, pasirinkite Modifiers skirtuką (wrench icon 🔧). 

Pridėkite Subdivision Surface modifikatorių ir nustatykite Levels = 2. 

Paspauskite Ctrl + A → Apply Scale (kad teisingai veiktų fizika). 

 

3⃣ Pridėkite pagrindą 

✅ Sukurkite grindis, kad kamuoliukas turėtų kur atšokti: 

Shift + A → Mesh → Plane. 

Paspauskite S ir ištempkite (S + 5). 

 

4⃣ Pradėkite animaciją 

✅ Animacijos lange nustatykite laiko juostą: 

Paspauskite Shift + Space → Timeline (apatinėje dalyje). 

Nustatykite animacijos trukmę, pvz., 80 kadrų (End = 80). 
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5⃣ Pirmasis animacijos kadras (kamuoliuko pradžia) 

✅ Nustatykite pirmąjį raktinį kadrą (keyframe): 

Pasirinkite kamuoliuką (Right Click). 

Perkelkite jį aukštyn (G + Z), pvz., Z = 3. 

Paspauskite I ir pasirinkite Location (sukuria raktinį kadrą). 

 

6⃣ Antrasis kadras (kamuoliukas ant grindų) 

✅ Nustatykite, kad kamuoliukas nusileistų: 

Judėkite į 40-ąjį kadrą (Arrow Right). 

Nuleiskite kamuoliuką prie žemės (G + Z, Z = 0.5). 

Paspauskite I → Location. 

 

7⃣ Trečiasis kadras (kamuoliukas vėl pakyla) 

✅ Kamuoliukas šokinėja: 

Judėkite į 80-ąjį kadrą. 

Pakelkite kamuoliuką atgal į viršų (G + Z, Z = 3). 

Paspauskite I → Location. 

 

8⃣ Pridėkite sklandų judėjimą 

✅ Atidarykite „Graph Editor“, kad pakeistumėte animacijos kreives: 

Paspauskite Shift + Space → Graph Editor. 

Pasirinkite kamuoliuko animacijos liniją (G ant „Z Location“ kreivės). 

Paspauskite T ir pasirinkite Bounce (tam, kad atšokimas būtų natūralesnis). 

 

9⃣ Pridėkite „Squash & Stretch“ efektą (neprivaloma) 

✅ Kad kamuoliukas elastingai susispaustų ir išsitemptų: 

Eikite į 40-ąjį kadrą (kai kamuoliukas ant grindų). 
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S → X ir Y ašyse (S + Shift + Z → sumažinkite). 

S → Z ašyje (S + Z → padidinkite). 

Paspauskite I → Scale. 

80-ame kadre atstatykite pradinį dydį (I → Scale). 

 

🔟 Eksportuokite animaciją 

✅ Išsaugokite animaciją kaip vaizdo įrašą: 

Eikite į Output Properties (printerio ikonėlė 🖨️). 

Failo formatas → FFmpeg Video. 

Spustelėkite Render Animation (Ctrl + F12). 

 

🎬 IŠVADA 

🎯 Jūs sukūrėte paprastą šokinėjančio kamuoliuko animaciją „Blender“ programoje! 

✅ Išmokote naudoti keyframes, Graph Editor, Squash & Stretch efektą. 

💡 Dabar galite išbandyti sudėtingesnes animacijas, pridėti tekstūrų ar daugiau fizikos efektų! 🚀 

 

Unity 

 

Kaip sukurti kamuoliuko animaciją su „Unity“? 🏀🎮 

Šiame vadove sukursime paprastą šokinėjančio kamuoliuko animaciją naudojant „Unity“. 

📌 Naudosime: ✅ „Rigidbody“ fizikos variklį 

✅ Animacijos komponentus (Animator, Animation Clips) 

✅ C# skriptą animacijos valdymui 

 

1⃣ Nustatykite darbo aplinką 

✅ Atidarykite „Unity“ ir sukurkite naują 2D arba 3D projektą. 

✅ Ištrinkite „Main Camera“ (Delete), jei naudojate „3D Core“ šabloną. 
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2⃣ Sukurkite kamuoliuką 

✅ Pridėkite sferą („3D“ režime) arba apskritimą („2D“ režime): 

3D: GameObject → 3D Object → Sphere. 

2D: GameObject → 2D Object → Sprite → Circle. 

Perkelkite kamuoliuką aukščiau (Y = 3). 

Pervardinkite į Ball. 

 

3⃣ Pridėkite pagrindą (grindis) 

✅ Sukurkite plokštumą ar kvadratą kaip pagrindą: 

3D: GameObject → 3D Object → Plane. 

2D: GameObject → 2D Object → Sprite → Square. 

Padidinkite jį: S → Scale X = 5, Scale Y = 1, Scale Z = 5. 

Perkelkite į Y = 0 (kad kamuoliukas galėtų ant jo atšokti). 

 

4⃣ Pridėkite fizikos variklį (Rigidbody) 

✅ Kamuoliuko kritimui ir šokinėjimui naudosime fizikos komponentą: 

Pasirinkite kamuoliuką. 

Add Component → Rigidbody (Rigidbody2D jei 2D). 

Nustatykite „Mass“ = 1, „Drag“ = 0 (kad išvengtumėte sulėtėjimo). 

Jei reikia stipresnio atšokimo:  

Add Component → Physics Material (su „Bounciness“ = 0.8). 

✅ Grindims pridėkite „Collider“, kad kamuoliukas nenukristų: 

Pasirinkite grindis. 

Add Component → Box Collider (Box Collider 2D jei 2D). 

 

5⃣ Pridėkite animaciją naudojant „Animator“ 
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✅ Pridėkite animacijos komponentą: 

Pasirinkite kamuoliuką (Ball). 

Add Component → Animator. 

Add Component → Animation. 

Create → Sukurkite naują Ball_Bounce.anim failą. 

„Animator“ lange sukuriamas Animation Controller. 

 

6⃣ Sukurkite animacijos klipą (Animation Clip) 

✅ Atverkite „Animation“ langą: 

Window → Animation → Animation. 

Paspauskite Create Clip. 

Pridėkite Keyframes („Raktinius kadrus“):  

Frame 0: Kamuoliukas aukštai (Y = 3) → Add Keyframe. 

Frame 30: Kamuoliukas žemai (Y = 0.5) → Add Keyframe. 

Frame 60: Kamuoliukas vėl aukštai (Y = 3). 

„Wrap Mode“ → Loop (kad animacija kartotųsi). 

✅ Išsaugokite ir peržiūrėkite animaciją „Animator“ lange. 

 

7⃣ Alternatyvus būdas: Kamuoliuko šuolio programavimas su C# 

✅ Jei nenorite naudoti „Animator“, galite sukurti animaciją per kodą. 

📌 Sukurkite naują skriptą BallBounce.cs: 

Right Click → Create → C# Script → BallBounce. 

Atidarykite „Visual Studio“ ir įrašykite kodą: 

using UnityEngine; 

 

public class BallBounce : MonoBehaviour 

{ 

    public float jumpForce = 5f; 
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    private Rigidbody rb; 

 

    void Start() 

    { 

        rb = GetComponent<Rigidbody>(); 

    } 

 

    void Update() 

    { 

        if (Input.GetKeyDown(KeyCode.Space))  // Kamuoliukas pašoka paspaudus SPACE 

        { 

            rb.velocity = new Vector3(0, jumpForce, 0); 

        } 

    } 

} 

✅ Užbaikite šiuos veiksmus: 

Išsaugokite skriptą. 

Pridėkite skriptą prie kamuoliuko:  

Pasirinkite kamuoliuką. 

Add Component → BallBounce.cs. 

📌 Dabar paspaudus Space, kamuoliukas šokinės! 🚀 

 

8⃣ (Neprivaloma) Pridėkite „Squash & Stretch“ efektą 

✅ Kad šokinėjantis kamuoliukas atrodytų realistiškiau: 

„Animation“ lange pridėkite Scale Keyframes. 

Kai kamuoliukas liečia žemę, sumažinkite Scale Y ir padidinkite Scale X. 

Kai kamuoliukas ore, atstatykite pradinį dydį. 

💡 Tai suteiks „guminį“ efektą kaip animaciniuose filmuose! 



42 
 

 

🔟 Išbandykite ir eksportuokite animaciją 

✅ Paspauskite „Play“ ir patikrinkite animaciją. 

✅ Jei norite eksportuoti kaip vaizdo įrašą, galite naudoti „Unity Recorder“ (Window → General → 

Recorder). 

 

🎬 IŠVADA: 

🎯 Dabar turite šokinėjantį kamuoliuką „Unity“ aplinkoje! 

🔹 Išmokote kurti animaciją su „Animator“ arba per C# kodą. 

🔹 Pridėjote fiziką ir interaktyvius elementus. 

🔹 Eksperimentuokite su skirtingais judesiais ir animacijomis! 🚀🎮 

 

Klausimai prieš egzaminą 
 

1. Mokinys kuria animaciją, kurioje veikėjai juda per skirtingas erdves ir laikus. Kaip turėtų 

būti parenkamas fonas? 

a) parinkti foną, kuris tiktų bet kokiai situacijai, 

b) pritaikyti foną pagal veiksmą ir laiką, kad jis papildytų pasakojimą, 

c) naudoti foną, kuris yra pats detaliausias, 

d) sukurti foną, kuris yra neutralus, kad tiktų visiems epizodams. 

 

2. Fonas yra svarbus, kuriant veikėjų emocijas ir bendrą nuotaiką. Kaip parinkti tinkamą foną? 

a) naudoti foną, kuris yra pats gražiausias ir vizualiai įspūdingiausias, 

b) pasirinkti foną, kuris kontrastuoja su veikėjais, kad juos išryškintų, 

c) išbandyti kelis fonus ir pasirinkti tą, kuris geriausiai atitinka norimą emociją, 

d) pasirinkti foną, kuris puikiai dera su pagrindiniu veikėju, net jei jis neatitinka situacijos. 

 

3. Mokinys kuria animaciją, kurioje veikėjas atlieka natūralų ir dinamišką judesį. Kaip jis galėtų 

patobulinti savo animaciją? 

a) naudoti standartinius animacijos modelius be papildomų pakeitimų, 

b) eksperimentuoti su skirtingais judesio greičiais, kad rastų optimalų rezultatą, 

c) palyginti savo animaciją su realiais judesiais, koreguoti ją pagal tai, kaip tiksliai ji atspindi natūralius judesius, 

d) nekeisti nieko, jei animacija atrodo pakankamai gerai. 
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4. Kas yra „judesio sekimas“ animacijoje? 

a) procesas, kai animacijos veikėjai yra sukurti naudojant išgalvotus judesius, 

b) technologija, kuri užfiksuoja realių objektų ar veikėjų judesius ir perkelia juos į animuotą aplinką, 

c) metodas, kai animacijos kadrai yra piešiami rankiniu būdu, 

d) procesas, kai animacija yra kurta naudojant garso efektus 

5. Kaip „judesio sekimo/fiksavimo“ (motion capture) technologija gali būti tobulinama, siekiant 

dar geresnio tikroviškumo animacijoje? 

a) naudojant daugiau sekimo taškų, kad būtų tiksliau užfiksuoti smulkūs judesiai, 

b) sumažinant animacijos trukmę ir paliekant mažiau detalių, 

c) pridėjus garso efektus ir muziką, kad veikėjai judėtų tikroviškiau, 

d) keičiant veikėjų padėtį scenos atžvilgiu. 

 

6. Mokinys kuria ėjimo animaciją, kurioje veikėjas turi atlikti skirtingus ėjimo etapus. Koks 

metodas yra tinkamiausias? 

a) sukurti kiekvieną ėjimo etapą atskirai be jokio atsižvelgimo į tarpus, 

b) naudoti automatinio animavimo įrankius, kurie generuoja tarpus tarp etapų, 

c) planuoti ir sukurti kiekvieną ėjimo etapą, atsižvelgiant į sklandų perėjimą tarp jų, 

d) naudoti vieną ėjimo etapą visame animacijoje ir nesirūpinti perėjimais. 

 

7. Kuris metodas tinkamiausias, kuriant veikėjo judesį nuo pradžios iki pabaigos animacijoje? 

a) sukurti kiekvieną judesio dalį atskirai, nekreipiant dėmesio į perėjimus tarp jų, 

b) naudoti automatinio animavimo įrankius, kurie generuoja tarpus tarp judesio dalių, 

c) planuoti ir sukurti kiekvieną judesio dalį, užtikrinant sklandžius perėjimus tarp jų, 

d) naudoti vieną judesio modelį visame animacijoje, nesirūpinant perėjimais. 

 

8. Mokinys animuoja veikėjo kūno kalbą, kur reikia perteikti kelias emocijas per tam tikrą laiką. 

Kaip jis turėtų tai atlikti? 

a) naudoti standartinius kūno kalbos modelius be papildomų pakeitimų, 

b) palyginti savo animaciją su realių objektų kūno kalbos principais ir koreguoti ją, kad ji tiksliai atspindėtų 

emocijas. 

c) eksperimentuoti su įvairiais kūno kalbos modeliais ir pasirinkti tą, kuris yra vizualiai įdomiausias, 

d) panaudoti tokį kūno kalbos modelį, kuris yra labiausiai įspūdingiausias. 

 

9. Kūno kalba animacijoje yra svarbi emocijoms išreikšti. Koks yra pirmas žingsnis, kai norima sukurti 

emocijas perteikiančią kūno kalbą? 

a) naudoti atsitiktinį kūno kalbos modelį iš programos bibliotekos, 

b) atsižvelgti į veikėjo emocijas ir viso kūno pozas, kad tinkamai perteiktų jausmus, 
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c) kurti kūno kalbos animaciją pagal savo nuotaiką, 

d) pasirinkti bet kokį kūno kalbos modelį, nesvarbu, ar jis tinka scenai svarbu, kad įdomus ir patrauklus. 

10.  

 

Atsakymas: c 

 

11. Mokinys kuria animaciją, kurioje reikia perteikti emocijas ir sinchronizuoti lūpas su kalbos 

garso takeliu. Kaip jam tai atlikti, siekiant užtikrinti, kad animacija būtų natūrali ir tiksliai 

atspindėtų emocijas? 

a) naudoti standartinius lūpų modelius, neatsižvelgiant, kaip jie atitinka garso takelį, 

b) lyginti savo animaciją su realių objektų kalbos modeliais ir koreguoti lūpų pozicijas, kad atitiktų kalbos garsus 

bei emocijų išraišką, 

c) eksperimentuoti su įvairiomis objektų lūpų padėtimis be konkrečių taisyklių, 

d) panaudoti lūpų judesius, kurie yra sukurti. 

12. Lūpų sinchronizacija (angl. lip sync arba lip synchronization) yra procesas, kuriame animacijoje veikėjų lūpų 

judesiai yra sinchronizuojami su garsu, ypač su dialogais. Kam reikalinga lūpų sinchronizacija animacijoje? 

Atsakymas: Lūpų sinchronizacija užtikrina, kad veikėjai atrodytų, lyg jie kalbėtų ir garsai būtų 

natūraliai atitinkami jų lūpų judesiams. 

 

 

13. Kas yra lūpų sinchronizacija animacijoje? 

a) procesas, kuriame veikėjų lūpų judesiai atitinka jų kalbėtojo dialogo garsą, 

b) procesas, kuriame veikėjų lūpos keičiasi pagal foninę muziką, 

c) procesas, kuriame veikėjai rodomi kaip siluetas, 

d) procesas, kuriame veikėjų lūpų judesiai sutampa su aplinka. 

 

 

14. Kas yra deformacija animacijoje? 
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a) tai procesas, kurio metu objektas pakeičia savo spalvą, 

b) tai procesas, kurio metu objektas keičia savo formą ar struktūrą animacijos metu, 

c) tai procesas, kurio metu objektas pridedamas prie scenos, 

d) tai procesas, kurio metu objektas ištrinamas iš animacijos. 

 

15. Kodėl deformacijos yra svarbios animacijoje? 

a) jos leidžia pakeisti objekto spalvą, 

b) jos užtikrina, kad objektai atrodytų realistiškai judėdami, 

c) jos padeda sutrumpinti animacijos trukmę, 

d) jos leidžia animuoti objektus be tekstūrų. 

 

16. Kaip deformacijos prisideda prie sklandaus animacijos veiksmo? 

a) jos sukuria papildomą objekto spalvos gradientą, 

b) jos leidžia objektui išlaikyti natūralų judėjimą ir formą per animacijos seką, 

c) jos padeda animuoti objektą tik statinėje būsenoje, 

d) jos keičia tik objekto dydį, bet ne formą. 

17. Kaip tinklelio naudojimas padeda pritaikyti trečdalių taisyklę kadro dizainui? 

 

Atsakymas: c 

 

18. Mokinys kuria sudėtingą kadro dizainą ir nori užtikrinti, kad visos kompozicijos dalys būtų harmoningai 

suderintos. Kokia yra geriausia praktika naudojant trečdalių taisyklę kartu su tinklelio sistema? 

a) naudoti trečdalių taisyklę tik centrinėse kadro dalyse, o periferinėse dalyse ne, 

b) pritaikyti tinklelio linijas ir trečdalių taisyklę visose kadro dalyse, kad svarbiausi elementai būtų išdėstyti 

natūraliai ir subalansuotai, 

c) pritaikyti tinklelio sistemą tik vienoje kadro dalyje, ignoruojant kitus segmentus, 

d) naudoti trečdalių taisyklę atsitiktinai, nes tinklelio sistema nėra svarbi. 

 

19. Kas yra kadro dizainas animacijoje? 
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Kadro dizainas animacijoje yra esminė animacijos kūrimo dalis, apimanti vaizdų ir elementų komponavimą 

ekrane taip, kad būtų sukurta aiški, estetiškai patraukli ir efektyvi vizualinė pasakojimo struktūra. Jis apima 

įvairius aspektus, kurie padeda sukurti įtikinamą ir dinamišką vizualinį pasakojimą. 

20. Kaip trečdalio taisyklė ir kitų kompozicijos principų taikymas gali paveikti animacijos vizualinį pasakojimą ir 

žiūrovų įsitraukimą? 

a) jie leidžia animacijoje naudoti standartinius elementus ir nereikalauja kūrybiškumo, 

b) jie padeda sukurti dinamišką ir subalansuotą vizualinę kompoziciją, kuri gali padidinti žiūrovų įsitraukimą ir 

emocinį atsaką, 

c) jie leidžia sumažinti animacijos trukmę ir sumažinti kūrimo išlaidas, 

d) jie leidžia lengviau pridėti specialiuosius efektus ir garso takelius. 

 

21. Kada paprastai įgarsinimas yra pridedamas prie animacijos? 

a) kai animacija yra visiškai sukurta ir paruošta, 

b) prieš pradedant kurti animaciją, 

c) tiesiogiai animuojant kiekvieną veikėjo judesį, 

d) kai animacija dar yra koncepcijos stadijoje. 

22.  Kokia yra viena iš pagrindinių priežasčių, kad garso efektai ir dialogai dažnai pridedami animacijos kūrimo 

proceso pabaigoje? 

a) kad būtų galima lengviau pasirinkti animacijos stilių, 

b) kad būtų išvengta papildomo darbo keisti garso efektus, jei animacija pasikeičia, 

c) kad būtų galima sukurti daugiau animacijos kadrų, 

d) kad būtų galima keisti animacijos kadrų eiliškumą. 

 

23. Ką apima garso takelio parengimas animacijoje? 

a) garso efektų pridėjimą prie jau sukurtos animacijos, 

b) muzikos pasirinkimą be papildomų garso efektų, 

c) garso efektų, muzikos ir dialogų integravimą į animaciją, kad būtų pasiektas norimas garsas, 

d) animacijos vaizdo įrašų redagavimą. 

 

24. Kas yra garso takelio parengimas animacijoje? 

Garso takelio parengimas animacijoje yra procesas, kurio metu sukuriamas, redaguojamas ir integruojamas 

garso turinys, siekiant papildyti ir sustiprinti animuotą vaizdą. Šis procesas apima įvairius aspektus, nuo garso 

efektų ir muzikos iki dialogo ir aplinkos garsų, kurie kartu padeda sukurti įtraukiantį ir dinamišką animacijos 

kūrinį. 

 

25. Kodėl svarbu sinchronizuoti garso takelį su animacija? 
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a) kad būtų galima pritaikyti atsitiktinius garso efektus; 

b) kad garso efektai ir muzika tiksliai atitiktų veikėjų judesius ir veiksmus, sustiprindami animacijos poveikį; 

c) kad sumažintų animacijos trukmę; 

d) Kad būtų galima naudoti daugiau skirtingų garso takelių. 

 

26. Kodėl svarbu kruopščiai tvarkyti ir derinti animacijos kadrus montažo metu? 

a) kad būtų galima pridėti daugiau spalvų, atspalvių, padaryti išraiškingesnę; 

b) kad būtų apskritai galima sumažinti animacijos trukmę ir dydį; 

c) kad būtų sukurtas sklandus pasakojimas ir užtikrinta, jog visi kadrų perėjimai būtų natūralūs ir logiški; 

d) kad būtų galima padidinti animacijos detalių kiekį bei apimtį 

 

27. Kas yra animacijos montažas? 

Animacijos montažas yra procesas, kurio metu sujungiami įvairūs animacijos kadrų segmentai, kad būtų 

sukurta nuosekli ir įtikinama vizualinė istorija. Montažas apima ne tik kadrų ir scenų redagavimą, bet ir jų 

organizavimą, kad būtų sukurtas norimas pasakojimas, tempas ir emocinis poveikis. Šiuo etapu taip pat gali būti 

pritaikyti įvairūs efektai, pereinamieji momentai ir garso elementai, siekiant sustiprinti pasakojimą ir vizualinį 

stilių. 

28. Kodėl yra naudinga turėti biblioteką su sukurtais animuotais objektais? 

a) kad būtų galima atsitiktinai pasirinkti objektus; 

b) kad būtų galima panaudoti jau sukurtus objektus įvairiuose projektuose; 

c) kad būtų galima padidinti animacijos trukmę ir vaizdingumą; 

d) kad būtų galima sukurti daugiau spalvų, jų atspalvių, gradientų. 

29. Koks yra pagrindinis skirtumas tarp 2D ir 3D animacijos? 

a) 2D animacija naudojama tik filmams, o 3D animacija tik vaizdo žaidimams; 

b) 2D animacija kuria iliustracijas plokščioje erdvėje, o 3D animacija kuria objektus trimatėje erdvėje; 

c) 2D animacija apima tik piešinius, o 3D animacija tik vaizdo įrašus; 

d) 2D animacija yra brangesnė nei 3D animacija. 

 

30. Kodėl animacijos scenarijus yra svarbus animacijos kūrimo procese? 

a) nes jis numato techninius parametrus, reikalingus animacijos išsaugojimui pasirinkta kokybe ir formatu 

(renderinimui); 

b) nes jis padeda planuoti ir organizuoti animacijos veiksmus, veikėjus ir aplinką, kad būtų pasiektas nuoseklus 

ir aiškus pasakojimas; 

c) nes jis padeda parinkti animacijos garso takelį; 

d) nes jis skirtas vizualiai  tobulinti animacijos išvaizdą. 
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31. Kodėl svarbu animacijoje naudoti liekamąjį veiksmą? 

a) kad veikėjas atrodytų, kad jis buvo apšviestas iš skirtingų kampų; 

b) kad veikėjas atrodytų natūraliai ir nesustotų staiga, kaip atsitrenkęs į nematomą sieną; 

c) kad veikėjas galėtų kalbėti ir judėti sinchroniškai su garsu; 

d) kad būtų galima pridėti papildomų efektų ir spalvų. 

 

32. Kas nutiktų, jei animacijoje nebus naudojami liekamieji veiksmai? 

a) animacija atrodys visiškai natūraliai ir efektyviai; 

b) veikėjas atrodys lyg būtų apšviestas iš visų pusių; 

c) gali atrodyti, kad veikėjas staiga sustoja, sukeldamas nepageidaujamą įspūdį apie atsitrenkimą į nematomą 

sieną; 

d) bus paprasčiau kurti animaciją, nes nereikės papildomų detalių. 

 

33. Kaip tinkamai animuoti liekamąsias veiksmų sekas, kad jos atrodytų natūraliai ir būtų logiškos? 

a) pridėti atsitiktinių judesių pradžioje ir pabaigoje, kad būtų sukurta įvairovė; 

b) suplanuoti ir animuoti judėjimą už galutinės pozos ribų, atsižvelgiant į judėjimo greitį ir objekto masę, o 

vėliau palaipsniui sugrąžinti objektą į galutinę pozą; 

c) keisti veikėjo spalvą ir pridėti garso efektų kiekviename judėjimo etape; 

d) naudoti vieno animacijos kadro techniką. 

34. Kas yra pasirengimas veiksmui animacijoje? 

Prieš padarant veiksmą visuomet padaromas nežymus judesys priešinga kryptimi. Be pasiruošimo judesys 

atrodys negyvas ir mechaniškas. Pasiruošimo veiksmas tinka tik gyviems objektams. Neanimuoti objektai negali 

pasijudinti, todėl ir pasiruošimo jiems neprireiks. 

35. Ką reiškia terminas „ėjimas“ animacijoje? 

„Ėjimas“ animacijoje (angl. walking) yra animacijos technika, kuri vaizduoja veikėjo judėjimą, kai jis eina. Šis 

procesas apima veikėjo kūno judesių, pėdų žingsnių ir kūno balansavimo sinchronizavimą, kad būtų sukurtas 

natūralus ir tikroviškas ėjimo efektas. 

36. Kas yra labai svarbu kuriant „ėjimo“ animaciją? 

a) veikėjo veido išraiškos (lūpos, antakiai, akys); 

b) kūno svorio perėjimas, žingsnių ritmas ir kūno balansavimas; 

c) veikėjo drabužių spalvų ir modelių pakeitimai; 

d) foninių muzikos efektų pridėjimas, garsų kaita ir trikdžių šalinimas. 

37. Koks yra svarbiausias tikslas renkantis foną animacijoje? 

a) pakeisti veikėjų drabužių spalvas ir modelius; 

b) sukurti atmosferą ir kontekstą, atitinkantį animacijos temą; 

c) sumažinti animacijos failo dydį, kad būtų gali lengviau siųsti; 
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d) pridėti tinkamus garso efektus, kurie atskleistų esminę mintį. 

 

38. Kas yra animacijos eksportavimas? 

Animacijos eksportavimas reiškia procesą, kurio metu animacijos projektas ar jo dalys yra konvertuojamos į 

tam tikrą failo formatą, kurį galima naudoti skirtingose platformose, įrenginiuose ar programose. Šis procesas 

leidžia pasiekti ir platinti animaciją įvairiuose formatuose, priklausomai nuo galutinio naudojimo tikslo, 

pavyzdžiui, internetu, televizijoje, filmuose ar vaizdo žaidimuose. 

39. Kuriame paveikslėlyje yra pritaikyta trečdalių taisyklė? 

a)   

 

b)  

Atsakymas: b 

40. Kuriame paveikslėlyje yra parodytas greitėjimo veiksmas? 

 

      a 

      b 
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      c 

 

       d 

 

 Atsakymas:  a 
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